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TRANSYT 15.5.0 RELEASE NOTES 
 

Release: TRANSYT 15.5.0, 7th October 2016. 
 
A summary of new features incorporated into this new maintenance release is given below.    
 
For instructions of how to register TRANSYT, please see the SOFTWARE_REGISTRATION document provided 
in the product installation.  Updating from an earlier release of TRANSYT 15 will not necessitate re-
registration.  Note that you will need administrator permissions to install the software.   
 
Results from evaluation (non-optimised) TRANSYT 15.5 runs should give good agreement with previous 
versions of TRANSYT where newer features in TRANSYT 15 have not been activated.  However, results for 
some files may differ because of modelling improvements that are in this release. 
 
For further information on any of our software products please email us at software@trl.co.uk or go to 
www.trlsoftware.co.uk.  
 

Summary of new features and improvements and bug fixes in 15.5.0: 
(References to relevant sections of the User Guide are shown in brackets) 
 

Enhancements: 

u Modelling improvements 

o Automatic network structure minimisation used to speed up optimisation  

o Tool to auto-calculate pedestrian conflicts from network diagram (15.5.3) 

o Tool to auto-calculate pedestrian intergreens from a scaled network diagram (15.5.3) 

o Reducing cycle times is less likely to result in invalid initial timings 

o Option to set cell saturation flow values automatically 

o Minimum saturation flow value reduced to 50 PCU/hr 

u Data handling improvements 

o Saving of results for all analysis sets within one file (6.14.6) 

o Run all data sets in one go (Evaluation or optimised) using ‘run button’ dropdowns 
(6.8) 

o Red/green colour-coded tracking of up-to-date and out-of-date results (6.13) 

o Analysis and Demand sets can be colour-coded to assist in keeping track of 
categories of sets, or to match up related demand sets (12.5) 

o Main menu right-click options allow analysis/demand sets to be added or removed 

o User-selectable sharing of data items between data sets (12.3) 

o Local OD Matrix can use flows from another local OD Matrix (13.4.5) 
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o OD Matrices grids now only show locations associated with the currently displayed 
traffic type, making them smaller and easier to use 

o Ability to update multiples of same data item in one go, using a Data Grid.  Newly 
applies to dropdown selections and check boxes as well as text and numbers (6.12) 

o Dispersion coefficient data-entry simplified (24.1.4) 

u Lane-flow diagram “flow overlays” (10.10.9) 

o Show demand, achieved flow, or lost flow 

o Filter by origin and/or destination, by OD matrix or by OD Location  

u Network representation/diagram redesigned to improve ease-of-use (10) 

o Stop-lines improved (10.5) 

o Auto-set lane arrows, based on estimated traffic turning movements (10.5.2) 

o Quickly show results on background without network structure (10.10.4) 

o Manipulating backgrounds no longer suffers from annoying deselection   

o Option to suppress bend points (default is on) to speed up network creation (6.18) 

o Right-click ‘control type’ selection easier to use 

o Existing collections can now have items added to them, via the right-click menu 

o Second phases can now be specified using the traffic stream right-click menu 

o Connectors now have direction arrows 

o Improved scaling of overlays of pedestrian and vehicle flows 

o Option to hide toolbars 

o Quick flares now more visible (16.2.2) 

o Orange highlighting now easier to see when zoomed out 

o Most network overlays now have a full key 

u General graphical interface improvements 

o Ability to take any window outside of the main window by double-clicking on its 
header (6.17.2) 

o Fully labelled toolbars for ease-of-use 

o Layout of special data-entry screens (e.g. Main Data) improved 

o Multiple data editor windows can be open at the same time (7.4) 

o Freezing of data editor/data grid contents using new fourth-level padlock, allowing 
you to compare before and after results (6.11) 

o Stored window layouts now work with multiple monitors (6.17) 

o Size of the underlying structure (path segments) of a traffic stream network now 
reported in bottom right-hand corner of the main screen (6.8.1) 
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o New “Sync” button (see main menu) forces data grid to display data related to 
currently selected data item (9) 

o New “Fast mode” (see “Data” Menu) increases GUI responsiveness when working 
with large networks (6.6) 

o Copy and pasting of part sections of any data grid now allowed 

o Improved quality of copy and pasted graphics (including option to define image 
resolution) (10.4) 

o New “Exhaustive data outline” option (Default is off) hides non-essential items 
unless they already exist in the file (6.18) 

o Use of new default OD Matrix settings ensures the use of traffic nodes is optional 

o Various minor enhancements to Audit Trail facility (23.1) 

o Task List has wrapping text descriptions to make long messages easier to read 

u Other diagram improvements  

o New “phase diagram” option in stage sequence diagram (15.7.5) 

o Layout and available options for stage sequence diagram improved generally 

o In the stage sequence diagram, two options have been added to select alternative 
sequences and to set the currently displayed sequence as the active one (15.7) 

o Option to hide banned stage transition diagram in stage sequence diagram 

o Multiple cycling shown differently 

o Intergreen matrix banded stage changes more logically uses crosses instead of ticks. 

u Reporting Improvements 

o Enhanced file comparison that allows comparisons between separate files and also 
within the same file, e.g. between different data sets (20.4) 

o Vertical toolbar “Results” button to speed access to most important summaries (19) 

o Rows of tables containing the same data are collapsed down to a single “All” row, 
and hence reduces the length of reports.  

o Signal timing penalties now reported as part of the controller results (21.3.1) 

o Enhanced cyclic flow profile (CFP) and analyser graphs (19.4) 

o Both CFP and Traffic graphs can be added to reports in either single or double 
column format (19.4) 

o Wide-Area Matrix tables now available in the HTML report (21.1) 

o New option to suppress pedestrian tables (21.1) 

o Local matrices’ general settings now in HTML report 

o Minor Final Prediction Table improvements 
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Changes that existing users can look out for:  

u When adding traffic streams to the network diagram the default mode of operation has now  
changed, such that you now define the start and end of the traffic stream with two left mouse 
clicks, and use the scroll wheel to add bends between the left mouse clicks if needed.  A new 
user preference can be set to change this mode of operation to the old one 

u Access to the Time Distance Diagram moved to the “Tools” menu 

u The “XY Graph Designer” is now called the “Analyser Screen” (Consistent with JUNCTIONS 9) 

u Export back to earlier versions of TRANSYT is not currently possible. Files created with previous 
releases and versions can be imported 

u The Main Menu option “Data > Model and Results” is the new home for the Main Menu 
“View” tab items (which were also previously accessed via “Data outline > Network Options”)  

u In “demo mode” TRANSYT 15 now operates slightly differently - You can now access the results 
of all analysis sets.  You may also make a small number of data changes followed by an 
evaluation (un-optimised) run  

u Flow cells In OD Matrices that do not have a valid path associated with them are now coloured 
in light-yellow instead of grey.  This is because grey is used to indicate read-only status 
throughout the user interface 

u Fuel consumption parameters have moved to the “Data” menu and is now limited to one set of 
parameters 

u The facility to add graphs to reports has moved to the “Tools” menu 

u The animation button has moved from the main menu to the network diagram menu 

u The "Cruise Sensitivity Multiplier" and "Link Sensitivity" options have been removed 

u The network diagram lane arrows start off referencing the estimated “traffic turn styles” as 
shown in the “source flow data” of the downstream traffic streams.  Right-click options allow 
the arrows to be overruled for display purposes, so that they can be set to match those 
actually on-street  

u The timings diagram “Phase mode” has been removed 

u “Normal traffic” is used in most places instead of just “Normal” to ensure better understanding 
of the term  
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Bug Fixes: 

u Cycle Time graphs no longer fail to carry out all possible runs 

u Combined flare result now correctly capped at combined downstream capacity. 

u Time segment time periods now correctly shown in results 

u Distance bus travels when accelerating corrected 

u OD Path generation options such as “Limit Paths by length” now take account of multiple 
traffic types 

u Various minor HTML report fixes, e.g. order of items in report now matches order in 
configuration screen 

u Time Distance Diagram graphs no longer out of step by one second 

u Various other minor/trivial fixes 
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Summary of new features and improvements in TRANSYT 15*: 
(*TRANSYT 15.5 compared with TRANSYT 14.1) 

 
Traffic Behaviour Models: 

u Pedestrian Behaviour (‘walk-on-red’) model for pedestrian crossings at traffic signals 

u Caters for multiple cycle times within the one network 

u Significant speed improvements for network models 

u Improved (CPDM) advanced flare model 

u “Assignment Cost weightings” can now be applied to each traffic stream or link to allow wide-
area flow assignment to be influenced / calibrated 

u ‘Turning on red’ facility 
 
Optimisation: 

u Out-profile accuracy option to speed up optimisation 

u Automatic network structure minimisation used to speed up optimisation 

u Locking of a stage on one controller to a stage on another – Useful for modelling linked 
controller streams 

u Cycle Time Optimiser enhanced to take account of multiple cycle times 

 
Traffic Signal and other model features 

u Tool to auto-calculate vehicular and pedestrian conflicts and intergreens from a scaled 
network diagram  

u Option to auto-calculate traffic stream lengths from network diagram  

u Option to auto-calculate turning proportions and turning radii from network diagram 

u Auto-calculation of RR67 saturation flows  

u Phase type can now be recorded 

u Queue Probability (QueProb) tool now integrated into each link 

u File Import from TRANSYT 14 (and earlier versions) and export back to TRANSYT 14 

u Amber times displayed in network diagram and timings diagram 
 
Priority Junctions: 

u Priority crossroad objects calculate PICADY give-way coefficients (slope & intercept)*  

u Assigning of calculated slope and intercepts for priority crossroads to links or traffic streams* 

u Roundabout priority object caters for multiple circulating traffic streams 

*Use is subject to having a licence for PICADY 5 or later. 
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Traffic Flows 

u Explicit specifying of pedestrian flows 

u Improved OD Matrix features, e.g. filter paths by location 

u Extra filtering options for OD path generation 

u Time-varying traffic flow conditions available for Traffic Streams network structures 

u RR67 saturation flow estimation for major links 

u Choice of input units - PCU or vehicles 

u Add new traffic types with associated PCU factors 

 
Graphical User Interface:  

u New easier-to-use dynamic graphical user interface 

u Saving of results for all data sets within one file 

u Ability to run all data sets in one go (Evaluation or optimised) 

u User-selectable sharing of data items between data sets 

u Improved responsiveness, especially when using larger files 

u Ability to take any window outside of the main TRANSYT window  

u Stored window layouts now work with multiple monitors   

u Multiple data editor windows open at the same time 

u Freezing of data editor/data grid contents using new 4th-level padlock 

u Clutter and complexity reduction, i.e. new options to hide unrequired features 

u Data Grid enhancements, e.g. ability to update many items at once with the same value 

u Limit cycle times to SCOOT values  

u Improved and extended set of data-specific data-entry screens 

u Easier specifying of give-way conflicts 

u Local OD Matrix can use flows from another local OD Matrix   

u Ability to update multiples of any data item in one go, using a Data Grid  

u New “Sync” button to speed up access to currently selected data on a data grid 

u New Phase diagram added to improved stage sequence diagram  
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Network Diagram/Representation: 

u Redesigned throughout to improve ease-of-use 

u Lane-flow diagram “Flow overlays” shows demand, achieved flow, or lost flow 

u “Flow overlays” filtered by origin and/or destination, OD matrix or OD Location 

u New combined flow/queue animation of traffic 

u Simplified and improved representation of signalled pedestrian crossing representation 

u Integrated editable stage timing wheels 

u ‘Follow me’ option synchronises diagram view to current data item 

u Auto-set Lane arrows, based on estimated traffic turning movements 

u Text output ‘sets’ easier to select, display and can now be stored for use with other files.  

u 3-D representation of network (including new 3-D flow animations) 

u 3-D generic display of input data or results 

u 3-D model import 

u Saveable 3-D fly-through of network 

u New combined flow/stopped traffic animation and extended set of useful overlays 

u Add both CFP and Traffic graphs to reports in single or double column format  
 
Results and Reporting  

u Storage of results from multiple runs within TRANSYT (e.g. for different analysis sets) 

u Colour-coded tracking of up-to-date and out-of-date results 

u New output result: separate vehicle and pedestrian summaries 

u New output result: “Utilised (queue) storage” 

u SCATS® Split stage time (as a percentage of cycle) as both an input and a resultant value 

u New Report Configuration screen offering: 

o Ability to select  or deselect any table, graph or diagram 

o Saving of user-defined report ‘Configurations’ 

o Wide-area data now shown in HTML report 

u Combined results for complex flares 

u Enhanced Queue, Cyclic Flow Profile, and Analyser (X-Y) graphs 

u Choice of units: PCU or vehicles 

u Signal timing penalties now reported as part of the controller results 
 
 
 
 

http://www.trlsoftware.co.uk/


 

 

 

DD:   +44 (0)1344 770558 | E: software@trl.co.uk | www.trlsoftware.co.uk 
TRL Software | Crowthorne House | Nine Mile Ride | Wokingham | Berkshire | RG40 3GA | UK  
 

 
 
Auditing Tools  

u Saves file changes as you work  - Date, time and username stamped 

u Save file status, with option to auto-prompt each time a file is saved 
 
Third-party Links 

u TRANSYT – Aimsun 8 LINK*  

u TRANSYT – VISSIM 7 LINK*  

*use subject to having a licence for these ‘TRANSYT LINK’ products 
 
Technical  

u 64-bit 

u Works with Windows 7, Windows 8 and Windows 10 
 
Documentation  

u User Guide (AG70): Revised and extended 

u Revised and extended collection of Library and Sample Files  

http://www.trlsoftware.co.uk/
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CONTACTING TRL 

Email:  software@trl.co.uk 
 
Web:   www.trlsoftware.co.uk 
 
Tel:    +44 (0)1344 770758 
 
Fax:  +44 (0)1344 770356 
 
Downloadable Updates:   www.trlsoftware.co.uk/downloads 
 
Training Courses:   www.trlsoftware.co.uk/training 
 
 
The current version of TRANSYT is always shown on the product website at 
www.trlsoftware.co.uk/TRANSYT.  If a new release is available, maintenance holders of 
that major version can download the new release at any time via our download service by 
following the steps below: 
 
1. Send an email to software@trl.co.uk stating your name, customer ID and site, and 
requesting a download code for TRANSYT.  You may also telephone or fax TRL Software 
Sales. 
 
2. You will be provided by return with a Download ID, which will be valid for three days. 
 
3. Browse to www.trlsoftware.co.uk/downloads 
 
4. Enter your download ID and press the Download button. The download for the 
appropriate version of TRANSYT will then begin automatically.   
 
5. Open the downloaded .zip file and run SETUP.EXE.  This will replace your existing version 
of TRANSYT with the new version. 
 
6. Please note that if you have previously used the TRANSYT–AIMSUN LINK (Version 1) with 
TRANSYT 13 or TRANSYT 14, you will need to upgrade to Version 2 in order to link from 
TRANSYT 15.  N.B. TRANSYT 15 and TRANSYT-Aimsun LINK (Version 2) require separate 
unlock codes. 

 
 
 
 
SCOOT is co-owned by Imtech Traffic & Infra Ltd, TRL and Siemens Traffic Controls Ltd. 
SCATS® is a registered trade mark of the Roads and Traffic Authority of New South Wales in Australia and other countries. 
The pedestrian behaviour at traffic signals modelling algorithm used within TRANSYT 15 is used under licence from Transport for London. 

TRANSYT 15.5.0 Release Notes.docx (b) 

http://www.trlsoftware.co.uk/
http://www.trlsoftware.co.uk/
http://www.trlsoftware.co.uk/downloads
http://www.trlsoftware.co.uk/training
http://www.trlsoftware.co.uk/TRANSYT
http://www.trlsoftware.co.uk/downloads
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Previous releases:  
 
Summary of new features improvements and bug fixes in 15.1.1: 
 

u Fix: Source data now correctly interpreted on inter-matrix connections. 

u Enhancement: TRANSYT Aimsun LINK now works with Aimsun releases 8.0.8, 8.0.9 and 8.1.0 

u Enhancement: TRANSYT VISSIM LINK now works with VISSIM release 7.00.07 

u Enhancement: Timing Diagram - Stage timing text values now always appear in report 

u Enhancement: Timing Diagram - Phase delay durations easier to see 

u Enhancement: Timing Diagram - More options saved as File Preferences and also appear in report. 

u Enhancement: Give-ways on exits (connected directly to OD Location) now tolerated. 

u Enhancement: Priority Objects updated to notice presence of ARCADY 9 and PICADY 9 licences 

u Fix: Collections now work with the new PCU factors 

u Fix: Merged Collections now correctly reference renamed link and traffic stream IDs 

u Fix: Inapplicable pedestrian results no longer added to reported network totals 

u Fix: The accidental re-sizing of the report font-size, instead of scrolling the report, is now fixed 

u Fix: Adjusting the network spacing in a diagram now adjusts crossings too 

u Fix: Mini-roundabout “Arm Order” now correctly referred to as “Entry Order” 

u Enhancement: Report content - Small improvements and removal of various anomalies 

u Enhancement: Clearer text on images in reports 

u Enhancement: Unnecessary bookmarks automatically removed from exported Word file. 

u Enhancement: Stage Sequence Diagram – Improved readability in GUI and in the report 

u Enhancement: Various changes to graphical interface to accommodate DPI 125% setting 

u Enhancement: Controller Streams are now opaque white to make them easier to see 

u Enhancement & Fix: Dutch TxC calculation now reported for each traffic stream/link that it is requested for, instead 
of for each phase.  Results based on user-selected flow sources now provided 

u Collection of supplied Library Files updated – Three new files added 

u User Guide (Issue G): Revised to reflect the above changes, including a new section on filters and how to set up traffic 
streams controlled by two phases 

 
Summary of new features improvements and bug fixes in 15.1.0: 
 

u Enhancement: Choice of input flow units (vehicles or PCU) 

u Enhancement: Choice of output flow units (vehicles or PCU)  

u Enhancement: Ability to specify PCU factors for each traffic type 

u Enhancement: Ability to split normal traffic type into sub-categories, e.g. ‘Lights’ and “Heavies” (with associated PCU 
factors) 

u Enhancement: Synchro Import extended to convert imported total traffic flows and heavy vehicle percentages into 
an equivalent dual vehicle mix in TRANSYT. 
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u Enhancement: Audit Trail setting & currency file preferences now applied to Library files. 

u Enhancement: New warning message given if a phase is referenced but never runs 

u Enhancement: Point-to-point journey time table now displays start and end locations 

u Fix: Slow opening of files is resolved. 

u Fix: Calculated Dutch TxC output fixed.  

u Fix: Labels created in Network Diagram are now a more reasonable initial size 

u Fix: Mixed-model flares no longer causes a crash 

u Fix: Occasional crash when selecting the 3D option in Text Sets resolved 

u Fix: Multi-cycling options within Cycle Time Optimiser now working properly 

u User Guide (Issue F): Revised where needed to reflect the above changes 
 
 
Summary of new features improvements and bug fixes in 15.0.4: 
 

u Enhancement: Link to VISSIM 7 build into TRANSYT*  

u Enhancement: ‘Turning on red’ facility for traffic streams and links added  

u Fix: Maximum Flow ZERO warning suppressed when step-wise opposed turn model used  

u Fix: Composite Demand Set – Resultant Flows fault now corrected  

u User Guide (Issue E): Revised where needed to reflect the above changes  

*Use is subject to having a separate TRANSYT-VISSIM LINK 2 licence  
 
 
Summary of new features improvements and bug fixes in 15.0.3: 
 

u Enhancement: Network Diagram – Clearer text 

u Enhancement: Extra filtering options for OD path generation, helping to reduce the number of unlikely paths 
automatically 

u Enhancement: Assignment 

o “Assignment Cost weightings” can now be applied to each traffic stream or link to allow wide-area 
flow assignment to be influenced / calibrated 

o Created assignment paths and path flows now displayed 

o Option to suppress bus and tram assignment when assigning normal traffic 

u Enhancement: ‘First time use’ wizard added 

u Enhancement: Amber times displayed in network diagram and timings diagram 

u Enhancement: Revised pedestrian delay calculation  

u Enhancement: Cycle Time Optimiser – Option to plot P.I. for selected cycle time ‘zone’  

u Fix: out-profile accuracy optimisation now works effectively for all files 

u Fix: internal constraint-only cost optimisation fixed, improving auto-distribute starting conditions 

u Fix: Maximum Flow warning suppressed when no conflict exists for that movement 
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u Fix: HTML Report 

o Stage Sequence Diagram shows phase IDs 

o Individual traffic stream ‘advanced’ table now separately selectable, and a number of other minor 
improvements 

o Local OD “Paths” and “Path Flows” tables merged & reports “calculated flows” 

u User Guide (Issue D): Revised where needed to reflect the above changes 

 
Summary of new features improvements and bug fixes in 15.0.2: 
 

u Enhancement: New Pedestrian Behaviour (‘walk-on-red’) model for pedestrian crossings at traffic signals  

u Enhancement: Fuel consumption calculations updated to use latest WebTag data (October 2013)  

u Enhancement: ERIS software registration system updated, and now automates “run as administrator” requirement  

u Fix: A number of TRANSYT Import/Export issues resolved  

u Fix: A number of screen resolution/DPI setting issues (e.g. buttons off the edge of some windows) resolved  

u Fix: Comma separator issues resolved.  

u Fix: Journey time results now reported when using “Manual” cycle times  

u User Guide (Issue C) revised where needed to reflect the above changes  

 
Summary of new features improvements and bug fixes in 15.0.1: 
 

u Enhancement: Locking of a stage on one controller to a stage on another – Useful for modelling linked controller 
streams 

u Enhancement: Roundabout priority object now caters for multiple circulating traffic streams 

u Enhancement: Enables the use of the new TRANSYT-AIMSUN LINK 2 (subject to having a licence for it). The second 
version of this innovative linking product has the following key features: 

o Allows TRANSYT 15 to link to both Aimsun 7 and Aimsun 8 

o Links to both 32-bit and 64-bit versions of Aimsun 

o Enhanced to import and control any combination of fixed time controllers irrespective of what cycle 
time they are running. i.e. caters for multiple cycle times within TRANSYT  

u Enhancement: Network Diagram cell overlay animation now works for single cells 

u Enhancement: Conflicting traffic streams of pedestrian crossings now show up in red on Network Diagram. 

u Fix: Fault with multiple analysis sets and reporting of timings tables corrected 

u Fix: Auto-redistribute of timings now respects the individual controller optimisation restrictions, e.g. when auto-
distribute is enabled during optimisation it no longer affects controllers that have been removed from the 
optimisation order list. 

u Fix: Phase Optimisation of controllers with exactly 14 phases is now working. 

u Fix: Traffic Streams Data Screen: clicking on column headers no longer jumps away from the current item 

u Fix: Merge junction Screen: Buttons no longer off bottom of screen when using larger fonts 

u Fix: Report Results: Dutch TxC values now reported 

u User Guide (Issue B) revised: e.g. incorporates details of stage constraints. 
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